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c

Frames

The Web page elements known as frames are both alluring and confusing. They’re
alluring because they can display multiple Web pages in a single browser win-
dow—one independent Web page per frame. Clicking a link may change the page
in one frame, while leaving the contents of all the other frames untouched.

Frames offer an easy way to compartmentalize different elements within a single
browser window. For instance, you can create separate pages for navigation, ban-
ners, and articles. Each can appear in its own frame, with its own scroll bars (see
Figure C-1).

At the same time, frames can be confusing to build, since they require a multitude
of Web pages—including a special master page called a frameset—in order to
work. People who create Web pages by typing pure HTML code into a text editor
soon discover that building frames-based Web sites can be a frustrating exercise in
file management. Dreamweaver, on the other hand, reduces much of this complex-
ity by providing special Frames tools in the Insert bar’s Frames tab and letting you
preview exactly how the finished frames will look and work.

The Frame Page
What your Web page visitor cares about is what’s in the frames: the text and
graphics. But for you, the biggest challenge is creating the special Web page—the
frameset page—that gives the frames their structure. The frameset page itself
usually doesn’t contain text or graphics; it just describes the number, size, and
placement of the frames.
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The Frame Page This page tells a browser which Web page should load into each frame, whether
the frame has borders or scroll bars, and whether the visitor is allowed to resize the
frame by dragging its border.

Figure C-1:
Frames let you keep one or more
elements in place—the banner and
navigation bars shown here at
www.mnh.si.edu/africanvoices/, for
example—while other contents of
the Web page change. This way, the
banner and navigation bar remain
visible in one frame, even as your
reader scrolls to read a long page
full of text or even reloads the page
in another frame.
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The Frame PageNote: You may have heard of another frame technology called iframes. The <iframe> tag lets you
embed one Web page within another Web page. This way, you avoid having to use a frameset page, while
preserving the main benefits of frames.

Unfortunately, although the latest browsers can handle iframes, Dreamweaver doesn’t provide any WYSI-
WYG tools for adding them to a page. Of course, if your HTML chops are sharp, you can jump into the
document’s Code view and write the <iframe> tags yourself. See the chapter “Under the Hood: HTML” for
more on working with raw HTML code.

For a gentle introduction to iframes, check out this Web page: http://hotwired.lycos.com/webmonkey/96/
37/index2a.html?tw=authoring.

The frameset page accomplishes all this with the help of two HTML tags: the
<frameset> and <frame> tags. A <frameset> tag provides the superstructure of the
layout: the number and size of frame rows and columns, as well as the overall bor-
der properties of all of the frames. Nested inside the <frameset> tag, a <frame> tag
identifies the specifics for each frame: which page loads into the frame and what
visual elements—such as scroll bars—appear within the frame.

When your visitor’s Web browser loads a Web page that contains frames, it first
loads the frameset page and determines the number, size, and appearance of the
frames, as described in the frameset. It then draws each of the frames in the browser
window, and, finally, it downloads the Web pages that appear in each frame.

UP TO SPEED

When Frames Aren’t the Best Solution
Frames are useful for banner logos, navigation bars, and so
on. But if you look around, you’ll notice that not many big-
time Web sites use them. The reason: frames have serious
drawbacks.

First, bookmarks and favorites don’t always work with
frames. When you click a link inside a frame, a new page
loads inside it; if you click a link on that page, yet another
page will load. While it looks as if you’re on a different page,
the URL in the Address bar remains unchanged. That’s
because a Web browser uses the address of the frameset
page.

In other words, suppose you follow several links within a
single frame and then use your browser’s Add Bookmark or
Add to Favorites command. Later, when you select the
bookmark or favorite, you’ll see the frameset page and the
original pages inside it—you won’t see the page you wound
up on.

Printing a Web page with frames can be tricky, too. Since a
frames-based page is composed of multiple Web pages,
the browser doesn’t know which page you want to print.
Different browsers handle this dilemma differently, much
to the confusion of novice Web surfers who don’t under-
stand the frames concept. For example, if you’re using the
Mac version of Internet Explorer 5 to view the bottom page
in Figure C-2, and you click one of the navigation buttons in
the top frame, Internet Explorer thinks you’ve selected that
frame. If you then choose File ➝ Print, you’ll print only that
top frame—a useless row of buttons!

Still, used in moderation and in good taste (see Figure C-2),
frames can be an excellent addition to your bag of Web
tricks. Small sites, where users aren’t likely to print or book-
mark the pages, can make good use of frames. And you
needn’t use frames everywhere on a site. You can effec-
tively create small presentations within a site—such as an
online portfolio—that benefit creatively from frames.
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Creating Frames Tip: Since a frameset page is just an empty structure, you must also create Web pages for each frame you
wish to display. So, if you add three frames to a page, you’re actually creating four different Web pages: the
frameset page, plus a page for each of the three frames. Because frames create more Web site files for you to
manage, you may save yourself some headaches by keeping the number of frames in your site to a minimum.

Creating Frames
Before you begin creating frames, think about how they might best serve your Web
site’s structure. For instance, if you want a banner with the Web site’s logo or
name to appear at the top of each page, you could create a frame at the top to hold

Figure C-2:
Frames can be obvious and ugly, or subtle
and effective.

Top: This fictional Web page has five
frames. Notice the thick border between
the frames and the unnecessary scroll bars
that appear in the banner and sidebar.

Bottom: This page (http://bmrc.berkeley.
edu/resources/) has three frames, but
since the borders are turned off, the
frames merge into a unified presentation.
Only a single scroll bar appears in the
content area (middle frame) of the page.
This is your only clue that this page uses
frames. In this example, the advantage of
using frames is that the site logo and
navigation buttons (top frame) and the
site tools (bottom frame) always remain
visible, even if you scroll to read the text
contained in the middle frame.
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Creating Framesit. Or, to help your visitors get around, you might include a navigation bar in a
frame on the left side of the page consisting of a list of links to the site’s main
sections.

To create frames:

1. Open or create a Web page.

This may be a new, blank page or a page you’ve already created. This is the page
you want to appear within a frame—for example, a page with a banner or a row
of navigation buttons. Next, you’ll create a frameset page around the current
page.

This may seem backward—you’d think you’d start with the frameset and then
put pages into each frame. But you’ll quickly get used to Dreamweaver’s ways.

2. Choose View ➝ Visual Aids ➝ Frame Borders.

You can also turn on the Frame Borders from the View Options menu in the
document toolbar, as shown in Figure C-3. A thick border appears around the
edges of the document window, indicating that you’re now working with
frames.

3. Create your frames within the window.

You can do so in any of three ways.

First, you can drag one of the frame borders that now sit at the edges of the doc-
ument window (Figure C-4). To create a frame at the left edge of your page, for
example, drag the left border inward toward the page center. To add a frame on
top, drag the top border down.

Figure C-3:
You can show and hide the frame
borders that appear in the
document window using the View
Options pop-up menu in the
toolbar. Making borders visible can
be an enormous help when trying
to understand what you’ve done
with your frame layout.

Frame borders
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Creating Frames Tip: You can create four frames at once—at the top, bottom, and both sides of the current page—by drag-
ging one of the border corners.

Second, you can choose Modify ➝ Frameset ➝ Split Frame Left, Right, Up, or
Down. This command may seem confusing at first, but it’s worth learning if
you want to make more complicated frame designs such as nested frames
(page 7). Just remember to make your choice based upon where you want the
current page to end up. If you want the current page to appear in the left frame,
choose Left. If you’d like it to appear at the bottom, choose Down.

Finally, you may prefer to use one of Dreamweaver’s one-click, canned frame
designs. These options appear on the Layout tab of the Insert bar, as shown in
Figure C-5. (You can also get to them from the Insert menu; choose Insert ➝

HTML ➝ Frames. The submenu lists the framesets available from the Frames
tab, plus four other options: Frameset, Frame, Floating Frame, and NoFrames.
These last four choices, are available only when you’re working in Code view.
To add NoFrames content while working in Design view, see the box “Don’t
Leave Anyone Out” on page 9.)

When you finish splitting or dragging, borders appear around the frames you’ve
just created. Behind the scenes, some strange things have just happened. First,
Dreamweaver has created a frameset page—a new, untitled Web page that
describes how a Web browser should draw the frames and which Web pages load
into these frames—around the Web page you started with.

Figure C-4:
Dragging one of the
frame borders around
the outer edge of a
document is a quick way
to create frames. When
the cursor is correctly
positioned to begin
dragging, it changes
shape (as shown here).
To create additional
frames within the page,
Alt-drag (Option-drag)
one of the inner frame
borders. As you might
have guessed, you can
resize your frames by
simply dragging the
borders. But for greater
precision, and to avoid
some potential problems,
see “Frame Size” on
page 13.
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Creating FramesSecond, Dreamweaver creates new, untitled documents for each frame you added
to the page. For example, in Figure C-4, the current page was split into two frames,
side by side. In the process, Dreamweaver created two new documents: a blank
document for the right-side frame and a blank document for the left-side frame.
You wind up with three pages (counting the frameset page).

For proof, try this experiment: Click a visible portion of the original Web page you
opened in step 1; note that the title bar of your window identifies its original name.
Now, if you click inside one of the blank areas around your original document
(that is, one of the other frames), the title bar changes to say Untitled Document.
That’s because you haven’t yet saved or named the new Web pages that make up
the new frames. You’ll do so in a later step (see page 10).

To eliminate a frame, just drag its border back to the closest edge of the document
window.

Note: If you use XHTML for your Web pages and you want to use frames, you have a little extra work in
store. Even if you’ve set Dreamweaver to use XHTML for all pages, this feature doesn’t work for framesets
(see this book’s Introduction for more on XHTML). As soon as you create one, Dreamweaver switches to
regular HTML for both the frameset and any frames within it. You can convert these pages to XHTML, but
it’s a bit time-consuming: you have to select each page (including the frameset and all other frames) in
turn and choose Edit ➝ Convert ➝ XHTML. (See page 10 to learn how to select frames and framesets.)

Nested Framesets
Although there’s no limit to the number of frames you can have in a single
frameset page, there are some restrictions on how you can arrange them. You
can’t, for instance, merge one frame into another, setting up a single frame that
spans multiple columns or rows. In other words, a design like the one pictured in
Figure C-6 is impossible using just a single frameset: the sidebar navigation spans
the entire left side of the window, while the right side has two horizontal frames.

Figure C-5:
The Frames button gives
you one-click access to
canned frameset designs.
Click a design to create
the frameset, complete
with blank pages for
additional frames. One
frame in each button of
the Frames panel is light
blue; that’s where
Dreamweaver will put
the current Web page.
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Creating Frames To overcome this limitation, you can insert a frameset inside of a frame. Nesting
framesets like this gives you much greater flexibility in your designs.

To nest one frameset inside another, just click inside the frame where you wish to
insert a new frameset. Then choose Modify ➝ Frameset ➝ Split Frame Up, Down,
Left, or Right.

Or, if you’d rather, you can use the Insert menu to insert frames. Choose Insert ➝

HTML ➝ Frames and select the location (for example, left or top) where you wish
the new frame to go. (You can’t drag frame borders to create a nested frameset.)

Figure C-6:
Here, frames keep the site identity
(top banner) and navigation (left
sidebar) visible. This site is made of
three frames (numbered) and two
framesets. To create this design,
start with a frameset divided into
two horizontal rows. Click the
bottom frame; choose Modify ➝
Frameset ➝ Split Frame Left.

3

1

Frameset 1  Nested frameset

2
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Creating FramesTip: Dreamweaver offers some common, canned frame designs that you can apply with a click of the
mouse. They’re on the Layout tab of the Insert bar (Figure C-5). Some of these designs include complex,
nested framesets.

The new frameset appears inside the original frame. (Because the borders of a
nested frame look just like regular frame borders, use the Frames panel, as shown
in Figure C-7, to keep track of what you’re doing.)

Figure C-7:
The Frames panel shows a thumbnail diagram of the current document’s
frames. Thick 3-D borders represent a frameset, while thin gray lines
represent the borders of frames. The thick black border—the outer
frameset in this example—indicates a selected frameset, while a thin black
border represents a selected frame. A name appears inside each frame to
identify it, so that you’ll know how to target links to the frame.

WORKAROUND WORKSHOP

Don’t Leave Anyone Out
Some very old Web browsers can’t display frames at all. For
the unlucky people who use these browsers, a Web site
with frames is rather useless. In fact, a browser that doesn’t
understand frames simply displays a blank page when it
loads a frameset.

You don’t have to leave these visitors in the lurch, however.
The <noframes> tag lets you add Web page content that’s
especially for, and can be viewed by, these old browsers;
frames-capable browsers simply ignore the <noframes>
content. Choose Modify ➝ Frameset ➝ Edit NoFrames
Content. The document window changes to an empty win-
dow, where you can add text, images, and other HTML.

Remember, what you put here is only for people who can’t
view frames, so don’t feel you have to duplicate your entire
Web site. One simple approach is to include a short mes-
sage—“This site requires a frames-capable browser”—with a

link to the Firefox, Microsoft, or Opera Web page, so the
person can download a newer browser.

Alternatively, you could link to a non-frames version of your
Web site. Of course, in that case, you’d have to do the extra
work of building an entire frame-free version of the site.

If you’re looking for publicity for your site, there’s one other
advantage to the <noframes> material. Many search-
engine “spiders” search and index the non-frames page
information. In other words, you could add a detailed
description, complete with juicy keywords, to the <nof-
rames> tag for the sole purpose of letting search engines
know what the page offers the world.

When you’re finished adding content for the <noframes>
page, choose Modify ➝ Frameset ➝ Edit NoFrames Con-
tent again to return to the document window.
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Selecting Frames
and Framesets

Selecting Frames and Framesets
Think of a frame as a mini document window; each frame contains a separate Web
page. When you click inside the frame, you can add images, text, and other ele-
ments to the page. Click inside another frame to edit that frame’s Web page.

However, since framesets aren’t visible elements of a Web page, Dreamweaver pro-
vides a special window—the Frames panel—that displays a simple visual overview
of frames and framesets, making it easier for you to select and modify them. To
open it, choose Window ➝ Frames or press Shift-F2 (see Figure C-7).

Selecting a frameset lets you save it and modify its properties, such as frame size
and whether or not there are borders, as described on page 12. There are several
ways to select a frameset:

• Click the thick border around the edges of the frames in the Frames panel. The
border becomes a solid black line to indicate the frameset is selected.

• Move the cursor over a frame border in the document window, slowly if neces-
sary, until it changes to a double-headed arrow; then click to select the border.
(This maneuver works only if frame borders are visible on the page: choose
View ➝ Visual Aids ➝ Frame Borders, or use the View Options menu in the
document window’s toolbar.) The gray frame borders acquire dashes to show
that the entire frameset is selected.

• The <frameset> tag also appears in the tag selector, providing yet another way
to select a frameset. (Make sure you’ve first inserted the cursor, or selected text
or graphics, inside a frame page.)

Selecting a frame lets you save it and modify its properties, including margins and
scroll bars, as described on page 10. To select a frame, do one of the following:

• Click a frame in the Frames panel.

• Alt-click (Shift-Option-click) a frame in the document window.

Saving Framesets and Frames
It’s always a good idea to save Web pages as soon as you create them. Further-
more, you probably do some of your most important formatting, such as choosing
a background color, right at the beginning, and you don’t want to lose that in a
crash or power failure. Finally, you need to save your frameset and all pages con-
tained in it before you can even preview the frameset.

To save a frameset, select it using any of the methods described on page 10. Then
choose File ➝ Save Frameset (or, to “spin off” a copy of the one you’ve opened,
choose Save Frameset As). The first time you save a frameset, the Save dialog box
opens. Name the frameset page and save it in your Web site folder. Although
frameset pages have special properties, they’re still just Web pages, and they still
end in the appropriate extension (.html or .htm for regular Web pages, or one of
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Saving Framesets
and Frames

the extensions—.asp, .php, and so on—used for the dynamic pages described in
Part Six of this book). You can save them anywhere in your site folder (see the
chapter “Introducing Site Management” for some filing tips).

Saving a component page inside of a frame works just like saving regular docu-
ments: Click the frame in the document window and then choose File ➝ Save
Frame, or press Ctrl+S (c-S). You can also save all of your frames at once, as
described next.

Saving Multiple Frames
One of the complexities of working with frames and framesets is the fact that
you’re dealing with many different Web pages at once and, consequently, many
different files. As you modify your frames and framesets and make changes to the
pages in those frames, you’ll be saving multiple files.

Fortunately, you don’t have to plod through the document window, clicking inside
each frame and saving it independently. To save all the pages in a frameset in one
step, choose File ➝ Save All.

Of course, just after you’ve created a frameset and frames, Dreamweaver doesn’t
yet know the component pages’ names or folder locations. It therefore shows you
the Save As dialog box (see Figure C-8) over and over again, once for each compo-
nent frame page, so that you can name and file each one.

Figure C-8:
The File ➝ Save All
command is a powerful
shortcut for quickly
saving a frameset and all
its pages. The first time
you save the frameset
and frame pages,
Dreamweaver places a
fat, crosshatched border
around the frame you’re
about to save, so you can
name each page
individually.
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Frame and Frameset
Properties

Clearly, you need to know which frame you’re saving each time the Save As dialog
box appears. To help you, Dreamweaver provides a visual cue: a thick, cross-
hatched border appears around the frame you’re about to save (see Figure C-8).
Type a name for that page and press Enter (Save), repeating the process for all
pages.

The same crosshatched border appears around the entire document window when
you’re saving the frameset itself.

Frame and Frameset Properties
After creating a frameset, it’s time to take charge of the size, look, and contents of
its frames. Dreamweaver treats framesets and frames as separate objects, each with
its own set of properties. When you select a frameset or frame, using any of the
methods described on page 10, you can view and modify its properties in the Prop-
erty inspector (see Figure C-9).

Tip: In general, it’s better to set a frameset’s properties before fine-tuning its frames, since some
frameset properties affect the properties of individual frames.

Frameset Borders
Borders are intended to visually separate one frame from another, but profes-
sional Web designers generally shun their amateurish 3-D appearance and the
boxy designs they create (Figure C-2, top).

If you’re a professional Web designer (or just want to come across as one), con-
sider eliminating frame borders entirely. Not only does this free up a few precious
pixels of screen real estate, it also lets you create seamless frame designs, so that all
your frames appear to be a single, unified Web page.

To control frameset borders, start by selecting the frameset itself (see page 10 for
selection techniques). Now consult the Property inspector, where you’ll find these
options:

Figure C-9:
The Property inspector
displays different properties
when a frame (top) or
frameset (bottom) is selected.
But all of the frames’
properties are stored in the
frameset file: their size,
border, source, and so on.
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Frame and Frameset
Properties

• Borders pop-up menu. Use this pop-up menu to indicate the visibility status of
the borders. To turn off borders, choose No—a good idea, if for tastefulness’
sake alone. If you must use borders, select Yes. (The Default setting has the
same effect as selecting Yes on most browsers.)

• Border Width. Specify the thickness of your border by typing a number (in pix-
els) into the field. Type 0 if you want to completely eliminate any borders. (You
might think that choosing No Borders would automatically eliminate any space
between frames, but that’s not the case. If you don’t also set the Border Width
to 0, a small gap will appear between frames on the page.)

• Border Color. Use this pop-up palette to choose a color for the border. Of
course, if you’ve turned off borders, you can leave this option blank.

The next time you save your document, Dreamweaver stores all of the new set-
tings (Figure C-9) into the frameset file.

Note: Nested framesets have their own border settings, but you don’t have to specify them, since nested
framesets inherit the border settings of the frameset they’re in. For example, suppose you created a
frameset and turned off the borders, and then you inserted another frameset into one of those frames
(see page 7). The borders in the nested frameset are automatically turned off, having inherited the set-
tings of the outer frameset. You can, however, assign completely different border settings for the nested
frameset, overriding any settings inherited from the outer frameset.

Frame Size
You can make your frames bigger or smaller simply by dragging the frame borders
in the document window. But for more precise, numerical measurement, you’ll
need the Property inspector.

Start by selecting the frameset containing the frame in question (see page 10). Now
consult the Property inspector’s controls, which include:

• Row/Column. Dreamweaver thinks of a frameset as something like a table, with
rows and columns. For example, if your frameset has two frames, one on top of
the other, Dreamweaver thinks you have two rows of frames consisting of one
“cell” each. Dreamweaver thinks of a frameset composed of three side-by-side
frames as three columns. (Beyond this similarity, however, framesets are totally
distinct from tables.)

Use this control (or the thumbnail diagram next to it) to specify the row or col-
umn you want to work with. Figure C-10 shows the details.

• Value. Here’s where you specify the height or width of the row or column. You
can choose either a pixel value or a percentage, whichever you specify using the
pop-up menu next to the Value field.
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Frame and Frameset
Properties

If you set a row height or column width to a percentage value, its size will be a
percentage of the browser window (or the parent frame, if the frameset is nested
inside a frame). That’s a handy design safeguard against the fact that every visi-
tor to your Web page may be using a different-sized monitor. You might set up
your left-side frame so that it always consumes, say, 25 percent of the window,
no matter how big or small the window is.

• Units. Using this pop-up menu, you can choose Pixels, Percentage, or Relative.

Relative is a special unit of measurement that you’ll probably want to use for at
least one column or row per frameset. To understand its use, imagine this
setup: Three frames appear one on top of another. The top frame is a banner
containing the Web site’s name, the middle frame is the main text, and the bot-
tom frame holds a navigation bar. If the heights of the top and bottom frames
are 30 pixels, and the middle frame is 300 pixels, the page will look just fine if
it’s viewed in a browser window that’s exactly 360 pixels tall (as shown at top in
Figure C-11).

However, if the visitor’s browser is much taller, the top and bottom frames
won’t be the height you wanted (see Figure C-11, bottom). You’ve told the
browser that the total height of the frameset should be 360 pixels (30 + 300 +
30), but the window is actually much bigger—on the order of 900 pixels. In an
effort to make the best of a bad situation, the browser just divides the remain-
ing space among the three frames, adding height to each of the three frames.

A relative measurement, therefore, lets you give a frame a flexible size. It will
grow and shrink to accommodate changes in the browser window. In addition,
it lets you assign absolute (fixed) sizes to certain frames—banners and naviga-
tion bars, for example—that always remain fixed in size.

Figure C-10:
The Property inspector’s Row and Column selector
shows a thumbnail of the frameset’s columns (top),
rows (middle), or both (bottom). In the first example—
two frames side by side—you can only set the width of
each frame, since the height is the entire height of the
browser window (or the parent frame, in the case of
nested framesets). In the second example—one frame
above another—only the height of each frame can be
modified. In the last example—four frames—you can set
a mixture of the two: height for each row of frames,
width for each column of frames.
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Frame and Frameset
Properties

Tip: If the notion of freely reflowing Web page contents doesn’t sit well with your design sense, and
you’d like a bit more control over your visitors’ browsers, see the chapter “Dreamweaver Behaviors” for
details on how to make browser windows open to the exact height and width you want.

Figure C-11:
You’ll usually want to assign a relative width or
height to one frame in each frameset. The relative
frame grows or shrinks as the browser window is
resized. Otherwise, as seen here (before the window
is resized, top, and after, bottom), all of the frames
resize, creating distorted banners and bottom
navigation bars. Better: Give the top and bottom
frames a set height—say, 30 pixels—and assign a
relative height to the middle frame.
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Frame and Frameset
Properties

Frame Properties
Once you’ve set the border properties and frame sizes in the frameset, you can
modify the properties of each frame. Select the frame and use the tools in the Prop-
erty inspector, as shown in Figure C-9, top.

Name

Each frame can have its own name, but this isn’t the name of the file (or the title of
the Web page) that loads into the frame. A frame’s name exists solely for identifica-
tion purposes when working with links or JavaScript scripts—specifically, when
you want to use a Dreamweaver Behavior (see the chapter “Dreamweaver Behav-
iors”) or target a link from one frame to another. You’ll need frame names, for
example, when you wish to use a navigation bar to load pages into another frame
(see “Targeting Links,” on page 18). Otherwise, frame names are optional.

Tip: If you create frames using the Frames tab of the Insert bar or the Insert ➝ Frame command, Dream-
weaver supplies generic names for the frames it creates. But if you use any of the other methods for creat-
ing frames, such as dragging frame borders from the edges of the window, you have to supply frame
names yourself.

To set the name of a frame, select the frame by clicking it in the Frames window,
and then type a name in the “Frame name” field of the Property inspector.

Src

When you set a frame’s source (Src) property, you’re simply specifying the path to
the Web page file that loads into that particular frame. You can change the path—
and the Web page that appears in that frame—by clicking the folder icon and
selecting a file from your site folder.

You can, if you like, link to a page that’s on somebody else’s site; just type the
absolute URL here, beginning with http://. You won’t, however, be able to see the
other person’s page within Dreamweaver. Instead, inside the frame you’ll see only
the words “Remote File,” plus the URL. You have to preview the frameset in a
browser connected to the Internet to see the remote file actually appear within the
page. (If you do display someone else’s Web page inside a frameset on your site, it’s
proper etiquette to ask for permission first. In fact, sites have been sued by compa-
nies whose pages have been “framed” in this way.)

Note: Be careful using the Src property. One common mistake is to add the frameset page itself to one
of the frames. In other words, it’s possible to click the folder icon next to the Src field, and then select the
current frameset page, thus creating a reference to itself.

When you then preview the frameset, the browser loads the page—but when it attempts to load pages
into each frame, it’s trapped: it loads the frameset, which in turn has a frame, which loads the frameset
again, which has a frame that loads the frameset again, and so on, and so on. This hall of mirrors contin-
ues until the browser crashes and your site’s visitors curse your name!
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Scroll

To create scroll bars for a frame—or hide them—use the Scroll property. You’ll see
four options in the Scroll menu in the Property inspector:

• Yes adds horizontal and vertical scroll bars to the frame, even if the frame
doesn’t contain enough material to require them.

• No prevents scroll bars from being added to a frame, even if that means some of
its contents become inaccessible.

• Auto lets the browser determine whether to display scroll bars. If the contents
don’t fit inside the frame, the browser adds the appropriate scroll bar.

• Default works like Auto in most browsers. Since the effect of the Default option
can vary from browser to browser, choose Auto instead.

In general, use the Auto option if you know your frame might require some scroll-
ing, or No if not. For example, a frame containing a Web page with a lot of text
will probably need a scroll bar, whereas a frame that simply contains the site’s logo
won’t.

No Resize

Usually, your Web site visitors can resize the frames you’ve created just by drag-
ging their borders right in the Web browser. But if you don’t want people monkey-
ing around with your designs, turn on the frame’s No Resize checkbox in the
Property inspector.

Tip: The No Resize option applies only to manual frame-edge dragging. In other words, even with No
Resize turned on, your frames may still change size when the browser window is resized. If you want to
prevent even that layout shift, see page 13.

POWER USERS’ CLINIC

Frames from the Inside Out
The Src property provides an alternative method for build-
ing a frames-based design, preferred by some designers
who learned to build frames-based pages before WYSIWYG
programs like Dreamweaver came on the scene.

Imagine that you want to build a page with two frames: top
and bottom. First you create a new page, add text and
graphics, and then save it as, say, top.html. Then you create
a second page, called bottom.html, and save it for use as
the bottom frame.

Finally, you need a third page, one that will serve to hold
the first two; split this third page into two frames. Set the
source (the Src property) for the top frame to top.html, set
it to bottom.html for the bottom frame, and save the
frameset using any name you like (like frameset.html, or if
it will be the home page to the site, index.html).

Using this technique, you make and save the frame pages
first and then create and save the frameset page: two
frames, three files.
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You can adjust the top and left margins of a frame by setting its Margin Width and
Margin Height properties. These settings control the position of the upper-left cor-
ner of a page in a frame, and they work exactly as page margins in a standard Web
page do. (In fact, you can set both page and frame margins. Your margins will then
be the sum of the two. For example, a 10-pixel top page margin and a 10-pixel
frame margin height will create a 20-pixel margin at the top of the frame.)

Margin width is the amount of space between the left edge of the frame’s border
and the left edge of the Web page; margin height is the space between the frame’s
top border and the top of the Web page. These margin settings apply to every page
that loads into the affected frame.

Border and Border Color

Using these controls, you can assign a border and border color to each individual
frame—giving one important frame a sky-blue border, say, but leaving all other
frames borderless.

Unfortunately, Internet Explorer, Netscape Navigator, and Opera all handle this
property differently, so you can’t assume that it will work for all of your visitors.
Furthermore, this option has no effect if you’ve turned off borders in the frameset
(page 12).

Targeting Links
Normally, when you click a link, the Web browser replaces the current page with a
new Web page, so that the entire browser window changes. But a browser treats
each frame as an independent window, which offers some interesting and unique
possibilities for linking. Clicking a link on a page merely replaces the contents of
that frame, leaving the other frames in place.

Using the Target property of a link, you can choose, or target, which frame you
wish the linked Web page to load in. This option is extremely handy when you use
one frame as a navigation bar whose links load pages into other frames.

To make a link open in a different frame, create the link as described in the chap-
ter “Links,” making sure that the link is highlighted. Then, in the Property inspec-
tor, choose the name of the frame where you’ll want the page to appear, using the
pop-up menu next to the Target field.

When you click the link on the finished Web page, the source Web page opens into
the frame you just chose.

Tip: Dreamweaver’s Go To URL behavior lets you have a single link target multiple frames at once. Imag-
ine loading four different Web pages with a single click! See the chapter “Dreamweaver Behaviors” for
more information on this powerful feature.
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Inserting a Navigation Bar
One of the best reasons to use frames is to keep a navigation bar visible on the
screen at all times. A navigation bar (called a nav bar in the trade) is a set of inter-
active buttons that let visitors jump to different pages or load pages into different
frames. To make your life easier, Dreamweaver’s Navigation Bar object makes
quick work of adding complex interactive navigation bars to your frames.

Like the Rollover object described in the “Images” chapter, nav bar buttons use
Dreamweaver Behaviors—JavaScript programs—to dynamically swap graphics
files. Nav bar buttons also offer two additional styles that help your visitors know
where they are in your site (see Figure C-12).

FREQUENTLY ASKED QUESTION

The Underscore Targets
What are the four choices in the Target menu that begin
with the “_” character?

If you’re working on a frameset page, the link target menu
lists all named frames. But even when working in another
kind of page, this pop-up menu always offers these four
options for a link you’ve highlighted:

• _blank opens a new, second browser window when
the link is clicked; the new window loads the linked
page. The original window—the one containing the
link—remains open. This feature lets you link to
another site, for example, leaving your own Web site
available in an open window. (To open a new
browser window to an exact size, see the chapter
“Dreamweaver Behaviors.”)

• _self loads the linked page into the same window
or frame, replacing the current page. Of course, this
is how links work normally, so there’s little point in
choosing this option unless you’re trying to get extra
exercise.

• _top offers a specialized, but very useful feature.
Suppose your Web page contains frames—and one
of them contains a link to someone else’s Web site.
If a visitor clicks the link, the “foreign” Web site will
appear trapped within one of your frames. This odd-
looking effect is widely considered bad form.

To avoid this HTML social gaffe, choose the _top
option for your link. This option forces your visitor’s
browser to load the linked page into the entire
browser window, which overrides all frames and
framesets, and avoids imprisoning someone else’s
Web site within your own.

• _parent replaces the current frameset page with the
linked page, exactly as the _top target does. The dif-
ference is visible only when the frameset page is
itself loaded into a frame in another frameset page.
In that case, this option will replace only the first
frameset. (Beware: Netscape Navigator’s support for
this feature is notoriously flaky.)
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To create a navigation bar:

1. Create graphics for the buttons in your navigation bar.

You’ll need to create multiple graphic files for each button, using a graphics
program like Fireworks or Adobe ImageReady. Since a navigation button can
have multiple appearances—states—depending on how the user interacts with
it (Figure C-12), you need a separate graphic file for each state. And, as with
rollover images, make sure that each button graphic is exactly the same size.
Otherwise, you’ll get distortion (see the chapter “Images”).

2. Place the cursor in the frame where you’d like to add a navigation bar.

It’s usually a sidebar, header, or footer.

3. Choose Insert ➝ Interactive Images ➝ Navigation Bar.

Alternatively, from the Common tab of the Insert bar, click the Navigation Bar
object.

Either way, the Insert Navigation Bar window opens (see Figure C-13). Don’t
be overwhelmed. There are a lot of options in this window, but they’re straight-
forward.

Just remember that a navigation bar is simply a collection of buttons. You add
one button at a time to create a complete navigation system. Each button has a
name, up to four different images, and a link.

The window starts out with a single element called unnamed.

4. Type a name for the first button in the “Element name” field.

This name is just for behind-the-scenes use in the Web page. It won’t appear on
the button or anywhere on the screen. If you like, you can even skip this step
and use Dreamweaver’s default names: unnamed1, unnamed2, and so on.

5. Click the Browser button next to the “Up image” field to select a graphics file
for the “up” state of the button.

This is the image you created in step 1.

Figure C-12:
When a button first
appears, it’s usually in its
“up” state—ready to be
clicked. But when the
mouse passes over, the
button changes to its
“over” state.
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6. Choose graphics for one or more states for the button.

At a minimum, include an “over” image. But including images for the other
two states of the button will add zing to your navigation bar.

These different state images are good for helping your visitors understand
where they are. For example, in Figure C-12, the frameset loads the first of three
pages covering a story about killer cabbages. The Week 1 button in the right
corner is in its “down” state, meaning that “You are at this spot in the story.”
The Week 2 button is in its “up” state, meaning that it’s clickable, and the Week
3 button is highlighted in its “over” state, since the mouse is hovering over it.
Because these buttons consist of ordinary graphics files, you can make their dif-
ferent states look like anything you want.

7. Type a text description for this button in the “Alternate text” field.

This optional step can be a help to those viewing the page with graphics turned
off or those who have vision impairments, as described in the chapter “Images.”

8. Using the “When clicked, Go to URL” field, specify the page you want the but-
ton link to open.

Since this is a navigation bar, clicking the button should take your visitor to
another Web page. You can click the Browse button to select a file from your
site, type in a path to a page in the site, or, to link to a page outside of the cur-
rent site, type an absolute URL beginning with http://.

FREQUENTLY ASKED QUESTION

Nav Bars, No Frames
Can I use the Navigation Bar object without using frames?

Yes, but you’ll lose most of the benefits of the Navigation
Bar feature and add unnecessary code to the page.

One of the cool aspects of a Dreamweaver nav bar is its
ability to indicate where the visitor is within the site, thanks
to the button’s “down” state.

Imagine this scenario. You’ve built two frames: a top frame
for a nav bar and a bottom frame for the main content. The
buttons in the nav bar are all in their “up” states. Moving
your mouse over the first button causes it to glow, and click-
ing it loads a new page in the bottom frame.

At the same time, the button you just clicked changes to
its “down” state, letting your visitor know what section of
the site he’s seeing. Only the page in the bottom frame
changes, because the top frame with the nav bar simply

uses a Dreamweaver behavior to swap the graphics used
for the buttons.

Now imagine that you didn’t use frames, so that you just
inserted the navigation bar on the same page as the main
content. When you click a button in the navigation bar, the
browser loads a new page, completely replacing the page
that had the navigation bar! You’d have to rebuild the nav-
igation bar on every single page of your site.

Moreover, the “down” state of the button would never
appear, because as soon as you click the button, a new
page replaces it.

In other words, there’s not much point to using the Naviga-
tion Bar object in Dreamweaver unless you’re also using
frames. If you want to create a frame-free site, it’s probably
best to just stick with Rollover objects (see the chapter
“Images”) for building navigation buttons.
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9. Select a Target from the pop-up menu.

Since you’re including the navigation bar in a frame of its own, the linked Web
page should load into another frame, leaving the nav bar exactly where it was.
Select the name of the frame from the menu, as described on page 18. The Main
Window option makes the Web browser replace the frameset and frames with
the linked page.

(The names of the other frames in a frameset appear only if the current frameset
is open and you’re adding the navigation bar to one of the pages in a frame. If,
for example, you’ve opened the navigation bar page by itself, Dreamweaver
doesn’t know the page is part of a frameset, or what the other frames’ names
are.)

Note: Don’t turn off the “Preload images” checkbox. Preloading images prevents a delay when a visitor
moves the mouse over the navigation image.

10. If you like, turn on “Show ‘Down image’ initially.”

The “down” image can function like a “You are here” sign, letting visitors know
their location in the site. You should select this option only for one button in
the navigation bar, and only if that button links back to the original frameset.

For instance, say your home page is a frameset, and one frame contains a navi-
gation bar. Select this option for the Home button on the navigation bar. This
way, when visitors peruse your page, that button is already highlighted—indi-
cating where they are.

11. Click the + button. Repeat steps 4–10 for each additional button in the naviga-
tion bar.

The minus sign (-) button deletes the highlighted button. The up and down
arrow buttons let you rearrange your buttons by shuffling a highlighted button
up or down in the list.

12. Choose the orientation of the bar from the Insert menu.

Navigation bars can run horizontally—perfect for headers and footers—or ver-
tically—the right choice for a sidebar.

Tip: To help control layout, turn on the “Use tables” checkbox. By containing your graphics within the
cells of a table, this feature keeps your graphics together on a page and prevents them from moving
around if someone resizes the browser window.

13. Click OK to insert the navigation bar.

You can only insert one navigation bar per Web page. Once inserted, you can
edit it only by choosing Modify ➝ Navigation Bar. The Modify Navigation Bar
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dialog box looks just like the one shown in Figure C-13, so that you can edit,
delete, and rearrange your navigation buttons.

To modify a button, select it in the “Nav bar elements” list. You can then assign
new images, settings, and links to it.

Tip: For more advanced navigation-bar features, see the chapter “Dreamweaver Behaviors.”

Figure C-13:
This navigation bar has
three buttons so far. The
different properties of the
button w1 appear here,
including its image files,
alternate text, link, and
target. Unfortunately, the
Horizontal/Vertical pop-
up menu and Use Tables
option are available only
when you first insert the
nav bar. If you want to
reorient the bar after
you’ve inserted the
object, you’ll have to do it
by hand.
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